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第一节 Adobe Audition 简介 
1.1 简介 

Adobe Audition (前身是 Cool Edit Pro) 是 Adobe 公司开发的一款功能强大、效

果出色的多轨录音和音频处理软件。它是一个非常出色的数字音乐编辑器和 MP3 制

作软件。不少人把它形容为音频“绘画”程序。  

 

1.2 基本编辑界面 

 

图 1-2-1 

Adobe Audition 的编辑界面主要是由工作区和素材框组成，在素材框上方的选项卡里可

以选择效果调板和收藏夹调板。 

Audition cs6 中文教程见末尾。 

第二节 Adobe Audition 的基本使用 
2.1 录音 

双击 Adobe Audition 的图标，打开程序，看见图 2-1-1，然后会进入 Audition 的编辑界

面（图 2-2-2）。 

 

图 2-2-1 
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图 2-1-2 

需注意的是，有的时候，尤其是第一次启动 Audition 的时候，会出现一些提醒用户设置

临时文件夹的界面，这个时候可以一路确定下去，直到出现编辑界面即可。 

进入编辑界面之后可以直接点击传送器调板上的录音键进行录音（图 2-1-3）。 

 
图 2-1-3 

 

会出现如图 2-1-4 所示的画面。 

 
图 2-1-4 

 

根据自己录音的需要，选择采样率和分辨率即可，选择完毕后，单击确定进入录音界面
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（图 2-1-5），此时就可以开始录音了，在录音的同时可以从工作区看到声音的波形。 

 
图 2-1-5 

 

录音完毕的时候，再次单击录音键即可结束录音。这个时候就可以用传送器调板进行音

频的重放，听听录制的效果。如果满意的话，选择“文件->另存为”（图 2-1-6） 
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图 2-1-6 

 

然后在弹出的窗口，选择保存的位置，更改文件名之后，单击保存即可（图 2-1-7）。 

 

图 2-1-7 

 

需要注意的是，在开始录音之后，应该先录制 10 秒左右的环境噪音，然后再开始录制

自己的声音，这样可以方便后期进行降噪处理。 

当然，也可以按照一般的步骤，选择“文件->新建”，然后会弹出图 2-1-4 的界面，选择

完之后，进入编辑界面，此时再单击传送器调板里的录音键，就可以开始录音了，之后的步

骤和先前所讲一致。 

 

2.2 基本编辑 

一般而言，我们做新闻所需要使用的，基本上也就是一些非常简单的剪辑工作，只需要

将我们录制的新闻和我们的解说剪辑在一起就行，使用的是非常简单的操作。 

2.2.1 单个音频的编辑 

对于单个音频，主要是降噪和去掉不必要的部分。降噪后面会专门讲到，这里就不说了。

去掉音频文件中不必要的部分，其实非常简单，只要选择住不需要的部分，然后按“delete”

键就可以了。 
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图 2-2-1-1（选择波形） 

 
图 2-2-1-2（按“delete”删除之后） 

 

音频的降噪 

对于录制完成的音频，由于硬件设备和环境的制约，总会有噪音生成，所以，我们需要

对音频进行降噪，以使得声音干净、清晰。当然如果录制的新闻，为了保证新闻的真实性，

除了后期的解说可以进行降噪之外，所有录制的新闻声音是不允许降噪的。 

我们假设已经录制完成了一段音频，在音频的最前面，是我们一开始录制的环境噪音（图

2-2-1-3） 
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图 2-2-1-3 

 

现在，我们先将环境噪音中不平缓的部分（也就是有爆点的地方）删除（图 2-2-1-4） 

 

图 2-2-1-4 

 

然后选择一段较为平缓的噪音片段（图 2-2-1-5） 
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图 2-2-1-5 

 

接着我们在右侧素材框上，选择效果调板，选择“修复->降噪器”（图 2-2-1-6） 

 

图 2-2-1-6 

 

双击打开降噪器，然后单击“获取特性”（图 2-2-1-7） 
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图 2-2-1-7 

 

软件会自动开始捕获噪音特性（图 2-2-1-8） 

 

图 2-2-1-8 
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然后生成相应的图形（图 2-2-1-9） 

 
图 2-2-1-9 

 

捕获完成后，我们单击“保存”，将噪音的样本保存（图 2-2-1-10） 
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图 2-2-1-10 

 

然后关闭降噪器，单击工作区，按“ctrl+a”全选波形（图 2-2-1-11） 

 

图 2-2-1-11 

 

再打开降噪器，点击“加载”，将我们刚才保存的噪音样本加载进来（图 2-2-1-12） 
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图 2-2-1-12 

 

接下来，我们要修改一下降噪级别。噪音的消除最好是不要一次性完成，因为这样可能

会使得录音失真，建议大家第一次降噪，将降噪级别调的低一些，比如 10%（图 2-2-1-13） 
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图 2-2-1-13 

 

再单击“确定”，软件会自动进行降噪处理（图 2-2-1-14） 

 

图 2-2-1-14 

 

完成第一次降噪之后，可以再次在噪音部分，重新进行采样，然后降噪，多进行几次，

没进行一次将降噪级别提高一些，一般经过两三次降噪之后，噪音基本上就可以消除了（图

2-2-1-15）。 
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图 2-2-1-15 

 

2.2.2 多个音频的编辑 

多个音频文件的编辑需要进入到多轨模式下进行。我们单击素材框之上的按钮“多轨”

（图 2-2-2-1）就可以进入多轨编辑模式了（图 2-2-2-2）。 

 

图 2-2-2-1 

 
图 2-2-2-2 

 

我们选择“文件->导入”（图 2-2-2-3） 
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图 2-2-2-3 

 

在弹出的界面中，选择我们需要使用的音频文件，单击“打开”，即可导入到素材框中。

（图 2-2-2-4） 

 

图 2-2-2-4 

 

这里我们导入了“JTV”和“JTV2”两个音频文件。（图 2-2-2-5） 
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图 2-2-2-5 

 

我们将这两个文件，分别拖放到音频 1 和 2 的轨道上，这时，我们可以对两个音频进行

编辑。首先我们需要将音频中不需要的部分删除，单击工作区上方的时间选择工具 ，然

后对准音频不需要的部分，选择（图 2-2-2-6） 

 

图 2-2-2-6 

 

然后按“delete”删除（图 2-2-2-7），这和单轨操作是一致的。 
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图 2-2-2-7 

 

有的时候我们需要将音频切成几个小段，方便声音的对齐。这时，我们用时间选择工具

单击需要切开的位置（图 2-2-2-8） 

 

图 2-2-2-8 

 

然后使用快捷键“ctrl+K”，或者选择“剪辑->分离”（图 2-2-2-9）这样就将音频切割开

了（图 2-2-2-10） 
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图 2-2-2-9 
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图 2-2-2-10 

 

接着，我们再利用移动工具 就可以对音频块进行移动（图 2-2-2-11），将音频对准。 

 

图 2-2-2-11 

 

对准完成之后，我们可以根据自己的需要对音频添加一些特效，这时只要选中我们需要

添加特效的音频块，然后再左侧素材框上选择效果调板，然后选择需要的效果双击打开，按

照降噪类似的步骤就可以完成效果的添加。 

 

多轨音频的导出 

多轨音频完成编辑之后，要进行输出，这时，选择“编辑->混缩到新文件->会话中的主

控输出”（图 2-2-2-12），按照需要选择立体声或者是单声道 
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图 2-2-2-12 

 

选择好立体声或者单声道之后，软件会自动开始进行混缩（图 2-2-2-13），并在单轨模

式下自动生成一个混缩文件（图 2-2-2-14），这时只要再按照单轨编辑的保存方式进行保存

就可以了。 

 

图 2-2-2-13 
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图 2-2-2-14 

 

第三节 音频编辑中的注意事项 
在进行音频编辑的时候，需要注意的是，如果是进行新闻录音的编辑，绝对不能使用“降

噪器”，对新闻音频进行降噪，只能使用“标准化”对音频的大小进行调节，要保证新闻的

真实性。另外多轨音频完成编辑之后，最好先试听，确定没有问题之后再导出。导出时最好

是选择“wav”或者是其他的无损或高质量的音频格式，作为留底保存，然后再选择符合规

范的音频格式进行发布。音频的编辑还有非常多的应用，但是作为一般我们编辑新闻而言，

这些已经足够，如果还想要进行更高阶段的编辑，需要大家自己去寻找相关的教程进行学习，

这里就不再多说了。 

第四节  教你如何制作歌曲伴奏（消除人

声） 
启动 Cool Edit Pro V2.0 程序，单击“文件（File）”菜单中“打开（Open）”

命令，打开需要进行原唱人声消除的歌曲文件。这时在屏幕窗口上方显示出所选

择歌曲的波形文件，选中整个波形文件，然后选择“效果（Effects）”菜单中

“波形振幅（Amplitude）”子菜单中“声音重混缩（Channel Mixer）”命令，
打开通道混音器对话框。如下图所示。 
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在通道混音器对话框中，可以对立体声的左右像位进行具体设置。对话框的左侧

区域为具体的左右像位量化控制区，右侧区域为一些常用的预设效果，比如单音

道转双声道、双声道同步、交换通道、人声消除等。其中的“Vocal Cut（人声
消除）”效果正是我们所需要的，它可以有效去除立体声中的人声演唱部分。在

此预设窗口中选择“Vocal Cut（人声消除）”选项，这时在左侧就出现了系统

预置的该选项的具体量化参数。单击右上角的“Preview（预览）”按钮，就可

以对所选择的歌曲进行试听，你可以实时听到经过消除原唱人声处理后的声音效

果。如果对处理效果不满意的话，还可以在左侧的控制区按照需要调整左右像位
的具体参数值，直到满意为止。单击“OK”按钮 Cool Edit Pro 就会立即对所选

择的歌曲进行正式的人声消除效果处理。处理完成后，系统加返回到主界面窗口，

选择“File”菜单中“Save As”命令，将处理后的歌曲文件保存到计算机中。 

注：使用此方法也会因为源文件所采用的制作方法不同，而会得到不同的处理效

果。一般情况下，这种处理方法对于结构比较单纯的对原始声音高保真的歌曲文

件(如 CD 音乐文件)可以达到非常好的处理效果。  

 

用 Cool Edit Pro 消除原唱的基本方法： 

  用 Cool Edit Pro 消除原唱，方法实际上可以说很简单，然而要想把它做的

很完美还是得下点功夫。 

  我这里说的“消原唱”只是 Cool Edit Pro 菜单中的一个独立功能，选择并
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使用就立即出结果。但是要想得到最好的效果，仅仅使用 Cool Edit Pro 的“消

原唱”菜单功能还是不够滴！！你还得进行跟多细致的音频处理和设置。无论如

何，还是先让我们尝试下最简单的“消除原唱”的方法。 

  首先进入“单轨编辑模式”界面。用“File”→“Open”调入一个音频文

件。我已庾澄庆的《命中注定》为例，文件名为“命中注定.MP3”。调入后选择

“Effects”→“Amplitude” →“Channel Mixer…..”（中文版的为“效

果”→“波形振幅”→“声道重混缩”），在“预置”中选择“Vocal Cut”见

（图 1），保持对话框上的默认设置，点“OK”按钮。经过处理后，就得到了《命
中注定》这首歌的伴奏音乐。“Vocal Cut”功能的原理是：消除声像位置在声

场中央的所有声音（包括人声和部分伴奏）。所以用此功能主要的还是要看伴奏

的来源，混音前是否有乐器和人声放在声场的中央，如果有的话用此功能都会把

它给消除掉，造成了音质的衰减。比如说一般声场放在中央的有“主人声”、

BASS……等等。如果大家需要消音音频来源是我说的这些原理的来源的话，我还
是建议不要使用此功能，这样人声没消掉到把伴奏音乐全给消除了。 

 

好了来试听下自己的成果吧！请非常仔细地听，你会发现伴奏与原声带的声音是
不同的。伴奏带中的原唱声音已变得非常“虚”，但是隐约还是能听到原唱的声

音，其实这就是所谓的消声后的效果（绝对滴消除原唱是不可能滴）。这样的伴

奏效果基本上可以拿去当作卡拉 OK 的背景音乐了，当你演唱时，你如牛般的吼

叫声足以能掩盖住原唱的声音了呵呵。如果不是要求很原版的伴奏的朋友，这个

因该还是行了吧呵呵。（这里我可还没说完喔！）  

 

  此外，整个伴奏带中的音频质量有所下降，我们所听到的是缺乏立体感的伴

奏声音（类似于单声道音频），还可能有一些“咝咝啦啦”的声音，低频部分也

被消弱了很多。或许你现在已经非常不满意这种效果了吧。下面我们就来学习一
些进阶的处理技巧，这里请留意下前面我所说的“消声原理”的思路。 

Cool Edit Pro 消原唱进阶： 

  先总结一下我们不满意的结果有那些。第一，原唱的声音似乎消除得还不够

干净；第二，有“咝咝啦啦”的杂声；第三，立体声效果降低了；第四，低频效
果减弱了。以下针对上述四个问题进行一一修正。首先在 Cool Edit Pro 中打开

“命中注定.MP3”原声带。 
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  1．把原唱声消除得更干净： 

  选择“Effects”→“Amplitude” →“Channel Mixer…..”（中文版的为

“效果”→“波形振幅”→“声道重混缩”），在“预置”中选择“Vocal 

Cut”。先前我们是以默认值处理，现在我们来试着调节左面的各个参数见（图

2）。在调节过程中，可以随时点“Bypassa (直通)”复选框来对比原音。 

  左面有两个“Invert (反相)” 复选框，默认状态下其中一个前面有

“√”，现在我们把“√”取消，声音变得更“干”，但是声场变得要开阔一些，

立体感增强，但低频被消减得更多。或许这个效果对某些歌曲比较合适，但对有
些歌曲效果不是很好，处理的时候还是得靠大家来慢慢、仔细的调试，如果次方

法对你要处理的歌曲不好的话，自然保持默认设置。 

 

此对话框在默认设置下已处于以最大程度消除原音的状态，因此要想把原音消除

的更干净，基本上在这里是没有任何办法的。我个人发现，不同人唱的歌曲，消

原唱的效果并不一样。有些会比较好些，有些就很不理想。但是我们可以通过“声

道重混缩”对话框左面的四个滑块对这项处理进行优化 见（图 2）。由于最终

效果受原声带的影响非常大，所以这里的调整没有固定的“定式”，只能将滑块

略微移动到中心点时，立体声效果会比较明显，但是人声也会变得比较明显。在

立体声和人声消除效果上，总得向一方妥协。这里先把处理后的结果保存为“命

中注定（伴奏）.MP3”。  

 

  2．消除“咝咝啦啦”声： 

  杂音来源于两处，这里我指的是伴奏里的杂声。第一，你的原声带经过了有

损压缩处理（如 MP3 或 WMA 编码），在经过“声道重混缩”处理后，自然就会显
现出来；第二，未消除干净的气声和齿音。所以条件允许，应直接将 CD 音轨以

WAVE 格式保存到硬盘在进行处理。 

  消除“咝咝啦啦”声一般要使用 Cool Edit Pro 的“均衡器”功能。首先调

入刚刚消除好后的伴奏“命中注定（伴奏）.MP3”，选择

“Effects”→“Filters” →“parametric Epualizer”（中文为“效
果”→“滤波器”→“参数均衡器”）。此“参数均衡器”对于初学着来说不是

很直观，这里不是很懂均衡器的朋友也可以选择用“图形均衡器”来调节，它的
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*作界面要比“参数均衡器”直观容易得多。这里我以“参数均衡器”来消除伴

奏中的“咝咝啦啦”声。“均衡器”的作用是增强或衰减某一频率段或某几个频

率段的声音强度。“咝咝啦啦”声通常处于 8000Hz 左右，我们将这一区域的声

音强度作衰减处理 见（图 3）。 

 
这一处理同时也有助于进一步消除人声。例如，一般人声的频响以中频为主，我

们可对中频部分做适当衰减。而气声和齿音主要在 6000Hz — 18000Hz 以上，也

可根据实际情况做衰减处理，但会损失伴奏的清晰度。均衡器一般用来做修补和

优化，人声的消除还得靠“效果”→“波形振幅”→“声道重混缩”来做。这里

处理完了别忘记了存盘喔！  
  3．立体声效果增强： 

  立体声效果增强属于比较专业的处理手法，由于一时不能完全的写出来，这

里我只简单说下立体声增强的方法，可以使用立体声效果起增强插件（如：WAVES

插件效果器材就是个不错的处理插件，这里我就不一一介绍了）或用专业的立体

声增强软件进行适当的调节，也可以适当的加入些混响效果。 

  4．低频补偿： 

  “命中注定（伴奏）.MP3”是我们经过了消除原唱、消除“咝咝”声后的结

果，但是它的音频被衰减了很多。要对低频进行补偿这里就可以用 Cool Edit Pro

的“均衡器”，但不要用已经“消过”声的这个文件，因为它的低频效果已经被

衰减了，若进行增益处理，效果一定没有原声带好，所以我们用原声带来进行处

理。取出原声带里的低频部分作为伴奏的补偿。 
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现在先调入“命中注定.MP3”原声带，选择“Effects”→“Filters” 

→“parametric Epualizer”（中文为“效果”→“滤波器”→“参数均衡

器”），进入“参数均衡器”后，将参数调节成图 4的样子。点“OK”后立即进

行处理，这样就能得到“命中注定”原声带里的低频部分，这里暂时先保存个文
件为“命中注定（BASS）.MP3”。（再次提醒大家，保存最好从一开始就用无损

的 WAV 格式来保存，这样最后出来的效果会好一些。） 

  5．多轨合成： 

  多轨合成这个可就不用我多说了吧，想必你一定很熟悉了，这里先把消过声

的“命中注定（伴奏）.MP3”插入到第一轨； “命中注定（BASS）.MP3”插入
到第二轨，混缩合成为就搞定了。如果觉得两个音轨的音量不是很均衡的话，这

里就可以在多轨下调节下两个音轨的音量，直到你听着伴奏很饱满很合适了在进

行混缩保存。 
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消人声的重点其实是在人声消除程度和播放效果上取得平衡，如果不考虑播放效

果，人声可以被消除的更干净，但这样做的必要性不大，只要你在唱歌时你的声

音能盖住原唱就可以了。这样以来伴奏带里的效果即能保证，原唱的声音也不会

太明显。 

 

第五节 Adobe Audition 专业理论知识 

（一）：信号发生器 

信号发生器是电子爱好者常用的工具，然而一般传统的信号发生器都难以产生特别精确的简

谐波形（倒是方波、三角波容易些），复杂的函数就更不要说了，需要花费巨额资金去实现。

现在好了，利用现代计算机强大的计算能力、Adobe Audition 软件的灵活设计和声卡的精

确输出，任意的音频信号都不在话下！ 

1. Adobe Audition 与 Cool Edit 

现在说 Adobe Audition 可能了解的人不多。但要说起 Cool Edit，只怕知道的不是少数，而

且许多人接触过这个由 Syntrillium Software 公司出品的著名的音乐编辑软件。事实上《无

线电》在 2002 年就介绍过 Cool Edit 2000。Adobe Audition 1.0 其实就是由 Cool Edit 
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Pro 2.1 换名变化而来的，因为 2003 年中期 Adobe 公司将 Syntrillium 公司全部产品都收购

了，用于充实其阵容强大的视频处理软件系列，其时 Cool Edit Pro 2.1 才发布不久。 

以前对 Cool Edit 2000 的介绍太片面，很多实用的强大功能没有认识到。事实上 Cool Edi

t 系列软件作为音频虚拟仪器的功能都是非常强大而全面的，都能够提供高达 96 kHz 的波

形发生、图示分析分析功能（只不过一般多媒体声卡不能处理超声信号，但高级专业声卡是

可以精确处理的）。特别是 Cool Edit 2000 之后的 Cool Edit Pro 2.0、2.1 版本，做出了

许多卓有成效的改进，与我们作为虚拟仪器的使用有关的则是在波形生成和频谱分析方面有

了很大进步，使得波形分析和数据处理变得十分容易，而在 CoolEdit2000 中则有很多局限。 

Adobe Audition 1.0 完全继承了 Cool Edit Pro 2.1 的特征，而拥有正版 Cool Edit Pro 2.

0、2.1 的用户可以免费升级到 Adobe Audition 1.0。如果想试用，Adobe 公司提供试用版

本，全部功能开通，试用期 30 天。大家可以到 http://www.adobe.com 公司网站去下载。不

过官方网站的下载过程有点复杂，我们为大家寻找到了一个可以快速下载的通道——http://

www.zdnet.com.cn/download/windows/system/swinfo/0,2008005299,39048180s,00.htm 

2. 生成简谐波形 

软件安装后打开，首先显示试用期限画面，点击“Try”按钮，就可以开始试用了。首次启动

的默认界面如图 1 所示。 

 

图 1 

http://www.adobe.com/
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这是“Multitrack View”，即多轨混排界面，一般用于音乐编排，于我们用处不大。可以点击

工具栏最左边的“Switch to Edit View”（切换到编辑界面），即可变成图 2 所示的编辑处理

界面。 

 

图 2 

快来试试怎么用！在这里点击“新建波形”按钮，就会弹出图中上浮的对话框，要求你选择“S

ample Rate”（取样频率）、“Channels”（声道数）和“Resolution”（分辨率）。对于电脑多

媒体声卡，一般用 48KHz 的取样频率、双声道、16bit 分辨率。如果要符合 CD 标准，则可

选取 44.1 KHz 的取样频率。而如果你有高档声卡，可以一直取到 192 KHz 取样频率，32

bit 分辨率。 

生成波形的最高频率与取样频率直接相关。根据奈奎斯特（Nyquist）取样原理，模拟波形

的最高频率为取样频率的 1/2。但实际上在接近 1/2 取样频率时软件生成的波形本身就很不

正常了，因此 CD 标准用 44.1 KHz 的取样频率来生成最高 20KHz 的信号就可以理解了。

有人采用低的取样频率而抱怨最高频率有限，或虽然采用高的取样频率却希望精确输出 1/2

取样频率的波形，那都是不理智的。 

选定参数后点击菜单栏的“Generate -〉Tones”（生成 -〉波形）按钮，即弹出图 3 所示的

对话框，要求输入波形参数。 

我们先产生一个最常用的信号，即 1KHz 正弦波。在“Base Frequency”（基本频率）栏目

添入 1000，将“Lock to these settings only”（固定设置）选中，在“General Flavor”（波

形类型）栏目选择“Sine”（正弦波），“Duration”（长度）栏目添入波形长度 10 秒，“dB V
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olume”（音量，波形幅度）栏设置成-6 dB（半满幅），其余项目选择默认即可。生成的波

形如图 4 所示。 

 

图 3 

 

图 4 

窗口左下角有两个工具栏，分别是“录放工具”和“缩放工具”，都用图标表示，而且有提示，

可以进行灵活自如的操作，非常容易使用，这里就不详述了。值得一提的是波形窗口的拖动

缩放功能，将光标移到其底部的时间标尺上按下鼠标右键拖动，光标即变成一个放大镜标志，

拖动完后放开鼠标，窗口即显示拖动过的部分。图中显示的是正在拖动的例子。另外如果用

左键拖动，则是用“手”移动波形，将“手”移到标尺外侧，波形将自动滚动显示。用上述方法

可以方便快捷地显示希望的部分。 
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显示全部波形，点击“播放”键试试，怎么样，声音放出来了吧？选择菜单栏“File -〉Save a

s”（文件 -〉保存为）命令，将按照跟其它标准的 Windows 应用程序一样的方法保存波形

到文件，想必大家都会，不用详述了吧。 

3. 生成调频波形 

调频波的产生由三个参数决定：“Base Frequency”（基频，载波频率）、“Modulate By”（调

制带宽，调制范围）、“Modulation Frequency”（调制频率）。这三个参数的含义容易令人

迷惑，而且帮助文件里的介绍也不容易理解，笔者费了很多工夫试验分析才弄明白，作出如

上翻译，希望读者注意。“Modulate By”（调制带宽，调制范围）的作用是设定在基频上下

的多大范围作调制，而“Modulation Frequency”（调制频率）才是真正用来调制基频的调制

频率。例如，基频选 1000 Hz，调制范围选 100 Hz，调制频率选 50 Hz，将产生在 900 

Hz 至 1100 Hz 间以 50 Hz 步长被 50 Hz 调制的调频波（实际上带外要产生谐波调制，不

过衰减较快）。一般情况下调制范围与调制频率接近即可，虽然这样不容易看清调制的情况，

但更接近实用。如果单作为演示看，可以加大调制范围，调制频率取 1/10 基频。例如基频

选 1000 Hz，调制范围选 500 Hz，调制频率选 100Hz，生成的波形如图 5A 所示，疏密相

间的频率调制波形很直观。如果调制范围选得太小，则调制幅度小，但频率成分很纯，反之

调制幅度大但频率成分很杂，如果调制范围选 0，则不会发生调制（所以我们在生成正弦波

时不必理会调制频率）。 
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图 5 

4. 生成调幅波形 

用 Adobe Audition 产生调幅波同样很方便，不过要分两步走。第一步，将基频设定成预期

值，调制范围和调制频率设为 0，产生基频；第二步，将第一步产生的基频全部选中高亮（即

刚生成波形时的默认状态），点击“GenerateàTones”，在弹出的对话框中选值，基频与第

一步相同，调制范围和调制频率设为预期值（二者相同将产生单频调制，调制范围小调制弱，

而调制范围大时则为多频调制），再选中对话框下部中间部分的“Overlap(mix)”(重叠混合)

选项，另外音量设置不能太高，否则容易发生削顶失真。可以进行二次、三次调制，产生复

杂的调制波形。例如基频设定 1000 Hz，调制范围选 100 Hz，调制频率选 100Hz，音量设

置选-9 dB，产生的波形如图 5B 所示。 

另外一种调幅波产生方法将产生过零的调幅波。在第二步基频设定 100 Hz（1/10 基频），

调制范围选 0，然后选中对话框下部中间部分的“Modulate”（调制），即可产生图 5C 所示

的调制波形。这样产生的调幅波可以用同样的设置再执行“DeModulate”（解调）来还原。

而这时如果执行“Overlap(mix)”（混合）命令，将得到图 5D 所示的复合音。         

5. 生成扫频 

音频扫频仪是测试音响系统非常需要的设备，以前我们个人很难有条件拥有高精度的扫频

仪，而如今，用 Adobe Audition 产生扫频易如反掌！ 

产生正弦波时将“Lock to these settings only”解除选定，将变为图 6 所示的界面。在这里

你可以设定“Initial Settings”（开试设置）和“Final Settings”（结束设置）两个页面。 
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图 6 

初试设置与产生单频正弦波一样，而结束设置则增加了一个“Log Sweep”（对数扫描）点选

框，将其选中，即可产生扫描速度对数增加的扫频信号。其好处是低频与高频的波形个数是

一样的。而如果不选则产生线性扫频信号，需要很长的时间才能产生低频完整波形。我们将

开始频率设为 20 Hz，结束频率设为 20KHz，产生一段 10 秒的对数扫频，其前 3 秒的波形

如图 7 所示。 

 

图 7 

6. 生成三角波、方波 

在“General Flavor”（波形类型）栏目有四个点选项目，即“Sine-Triangle/Sawtooth-Squar

e-Inv Sine”（正弦-三角/锯齿-方波-反正弦），选择“三角/锯齿”或“方波”，即可方便地生成需

要的波形。 
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这时窗口频率设置项下方的“Flavor Characteristic1”（波形特征）将变成图 8A、8B 所示的

样子，在这里你可以自由设置三角/方波的特征。图 8A 为三角波设置参数。可以填入 0 至 1

00 的数值来决定三角波上升时间比例。50%为纯粹的三角波，而 0%或 100%则成为下降/

上升的锯齿波。图 8B 为方波设置参数。可以填入 0 至 100 的数值来决定方波正值所占时间

比例。 

 

图 8 

7. 生成复合音 

复合音可以产生很多奇妙的效果，检测音频设备的互调失真也很有用。复合音是由基频和多

至四个的“Frequency Components”（频率组件）构成的。事实上上述图 5D 所示就是复合

音，由此可见复合音的产生也是有多种方法的，不过复杂的复合音还是以下方法好用。参考

图 9 ，这是软件预设的“Bell”（钟声）的构成情况，由基频 220 Hz 正弦波 100%幅度、第

一组件 1.02 倍基频 28%幅度、第二组件 0.98 倍基频 14%幅度、第三组件 4 倍基频 22%幅

度、第四组件 7 倍基频 39%幅度组成，然后经 1.5 Hz 调制频率在 2 Hz 带宽内调频，右声

道延迟 15°相位构成，变化至结束时各参数均改变，请参考实际应用，此处不再详述。  



36 
 

 

图 9 

对我们的虚拟仪器应用来说，能够产生几个纯音复合就够用了，不必进行复杂的调制和变化，

那样反而不容易分析。我们也可以将自己编辑的复合音设置保存起来供调用。点击“Preset

s”旁的“Add”键即可添加保存。 

8. 技巧进阶 

根据上述内容，想必大家已能领略到 Adobe Audition 生成波形的强大威力了。不仅如此，

配合下述的技巧和以后介绍的编辑功能，你真的能产生几乎任意想要的波形，说“万能”并不

很夸张。 

在生成正弦/反正弦波形时，“Flavor Characteristic1”框内可以填入任意的实数来决定波形的

指数。默认的“1”当然是基本波形了，我们甚至可以填入小数、负数来产生任意次方的波形！ 

“Phasing”（相位）栏可以设置波形的相位特征。这里你可以设置“Start Phase”（开始相位，

指左声道）、“Phase Difference”（相位差）和“Change Rate”（变化率）是指右声道相位

相对于左声道的相位差和变化率。如果设定了相位变化率，频率也会随着变化。 

在“Generate”菜单栏还有三个项目，分别是“Silence”（静音）、“DTMF Signals”（双音多频

信号）和“Noise”噪音。 
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“静音”即数字 0 信号，可以在波形片段间插入绝对静寂。而“双音多频信号”即电话拨号音，

你只需输入数字和字母即可得到标准的电话拨号音，甚至可以自由设计双音多频信号的特

征！ 

 

图 10 

“噪音”也需要产生？！是的，这可不是随随便便的噪音，而是频谱非常精确的噪音！如图 1

0 所示，你可以选择噪声的“Color”（颜色）为“Brown”（褐噪声）、“Pink”（粉红噪声）或“W

hite”（白噪声）。这是借用了光谱分析中的术语而得来的，因为它们与对应的颜色频谱规律

类似。褐噪声的频谱线幅度随频率增加而以-6dB/oct（每倍频程-6dB）的斜率衰减，而粉红

噪声则为以-3dB/oct（每倍频程-3dB）的斜率衰减，白噪声则保持恒定。这里产生的噪声频

谱极宽，全部为从 0 至 1/2 取样频率，使用时要注意防止损坏被测设备。如果希望只用音频

范围，可以用以后介绍的编辑方法处理。 

“Style”（类型）是针对双声道间的关系而言的。在“Spatial Stereo”（空间立体声）输入框

内填入数值可以产生相关的立体声噪音，而“Independent Channels”（独立声道）则产生互

不相干的两声道，“Mono”（单声道）则两声道相同，“Inverse”则两声道间反相。怎么样，

模拟设备做不到吧？ 

“Intensity”（强度）用来设定噪声的总幅度。只有粉红噪声才能设到最高值 40，白噪声和褐

噪声必须分别限制在 12、18 以下，否则会发生削顶失真。还有一些项目未能尽述，大家可

以参考帮助文件自行探索。 

（二）：频谱分析仪 

频谱分析仪是研究信号频谱特征的仪器，在电子技术一日千里的今天，是研究、开发、调试

维修中的有力武器。现代频谱分析仪都趋向于智能化，虚拟仪器技术广泛应用，有些就是以

专用的计算机系统为核心设计的。其结果是结构大大简化、性能飞速提高。当然专业的频谱
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分析仪就比示波器更加昂贵了，业余爱好者更难用上。不过不必灰心，我们可以充分利用 A

dobe Audition 的频谱分析功能，让你拥有精确频谱分析仪的美梦成真！ 

1. 频谱显示模式 

Adobe Audition 本身有一种“频谱显示”模式。先打开一段波形，或用《妙用 Adobe Auditio

n：数字存储示波器》一文介绍的方法录制一段波形，即可进行频谱分析。这里我们新建一

段 20 秒的对数扫频信号（本文大多选用直接建立的波形，以便了解信号原始波形的标准频

谱特征），然后选择“View=>Spectral View”（视图=>频谱），如图 1，或点击快捷工具栏

的“Toggle between Spectral and Waveform views”（切换频谱视图/波形视图）按扭，即

可将波形以频谱显示的方式显示出来，如图 2。扫频的频谱显示见图 3。 

 

图 1 

 

图 2 
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图 3 

可以看到，横轴为时间，纵轴为频率指示。每个时刻对应的波形频谱都被显示出来了，可以

看到扫描速度是指数增加的，即将频率轴取对数时扫描速度是线性的。如图中光标处 18 秒

处频谱指示约 11KHz。实际上频谱指示的颜色是代表频谱能量的高低的，颜色从深蓝到红

再到黄，指示谱线电平由低到高的变化。这实际上跟地图的地形鸟瞰显示是比较相似的，看

图 4 频谱复杂变化的声音频谱就更容易理解这点了。 

 

图 4 
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2. 频谱分析操作 

“频谱显示”模式虽然能大致显示出波形频谱分布的情况，而且能给出时间方面的特征，但是

从精确分析的角度讲就难以满足要求了，这时我们就要用到 Adobe Audition 的“频谱分析”

功能。打开一段波形，例如上述的扫频，点选“Analyze=>Show Frequency Analyze”（分

析=>显示频谱分析）即可打开图 5 所示的频谱分析窗口。 

 

图 5 

默认的窗口比较小，而且分析结果比较粗糙。选中“Linear View”（线性视图）时频率标尺

是线性刻度的，这时低频段显示很少，不符合常规要求，可以取消选定，频率标尺将以对数

刻度显示。左下角的选择条可以让你选择“Lines”（线条）、“Area”（区域）、“Bars”（条状）

来显示频谱，一般选择线条为好，否则前面的都会盖住后面的频谱。虽然窗口没有“最大化”

操作按扭，但我们将光标移到窗口右下角就会变成图示的双箭头，这时按住鼠标左键拖动，

即可将窗口放大，然后点到顶端蓝条拖动即可移动窗口，这样你可以一直放大到满屏幕。（提

示：许多 Windows 程序都可以这样操作）。将波形全部选中，可以执行“Scan”（扫描）操

作（提示：不选中不能扫描！），将整段波形的总频谱显示出来。图 6 就是上述扫频的总

频谱曲线。 
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图 6 

点击“Advanced”（高级）按扭，即可打开几个高级设置选项，如图 7。 

 

图 7 

在“Reference”（参考电平）栏可以填入任意值来作为参考电平。而“FFT Size”（FFT 样本

数）可以设置 FFT 分析的样本数值，即将每秒长度的波形分成若干份来分析。当然数值越

高，频率分辨率越高，最高可以设到 65536（这时可以将 48 KHz 取样的波形精确到 0.732

 Hz 的步长来分析）。滤波类型选择窗口可以选择五种 FFT 分析滤波窗口类型。不同的窗
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口具有不同的特性，可以参考软件帮助文件使用，一般我们用“Blackmann-Harris”即可。点

击“Copy to Clipboard”按扭可以将频谱分析数据拷贝到剪贴板。然后你可以将它粘贴到其

它软件中进行处理，例如微软的 Excel 电子表格软件就可以很好地处理。不过这时我们一般

不要将“FFT Size”设得太大，否则数据量庞大，处理不便。 

3. 解读频谱分析结果 

你是否对上述扫频频谱分析结果感到迷惑不解？明明我们产生扫频时设定的波形幅度是恒

定的，为什么分析结果却成了随频率增加而衰减？要揭开这个迷团，必须对 FFT 频谱分析

的实质有深入的了解。 

与传统的模拟频谱分析仪不同，计算机 FFT 频谱分析是基于“能量累积”的计算而得到的，由

标准的 FFT 计算公式就可以看到它是一个相对于时间的积分公式。对于对数扫频这样频率

成分比例随时间变化的信号，后期分析是针对整段波形的，其结果就是谱线幅度由该频率波

形所占时间比例来决定，因此产生上述的结果。如果扫频是线性扫描的，结果自然就是一条

水平直线。这是 Adobe Audition 的后期分析特点。其优点是对硬件要求低而可以慢慢分析，

得出精确的分析结果。如果用实时分析，精确分析对硬件速度要求是比较高的。我们应该用

“能量”的观点来解读分析结果。即频谱曲线指示出一段信号中各频点的能量分布情况。对此

我们要有清醒的认识，否则会做出错误的判断，得到错误的结论。特别的对于音乐信号，高

频段所占能量比例一般不大，却可能出现幅度相当大的尖峰。 

如果是实时分析模式（即“频谱显示”模式的样子，可惜精确分析时不具备该功能，要得到精

确的实时分析结果，还需要用到本系列软件的下一个更专业的软件），对数扫频与线性扫频

结果就是一样的，只不过扫描速度有差别而已，跟模拟频谱仪的等带宽滤波分析一样。如果

各信号成分是同时给出的，并且是均匀分布的，例如粉红噪声、白噪声、复合音、调频信号，

实时分析与后期分析的结果就一样了。 

4. 频谱分析示例 

了解了软件的操作技巧和分析特征，有助于充分了解实践中的分析结果。现在就让我们来做

几个常见波形的频谱分析实验。图 8 是 100Hz 三角波的频谱。奇数倍的谐波幅度以-12dB/

oct（每倍频程-12dB）的斜率衰减。 
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图 8 

图 9 是 100Hz 方波的频谱。奇数倍的谐波幅度以-6dB/oct（每倍频程-6dB）的斜率衰减。 

 

图 9 

图 10 为粉红噪声频谱。频率成分是连续的，以-3dB/oct（每倍频程-3dB）的斜率衰减。 
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图 10 

再看看调制波形的频谱。用《妙用 Adobe Audition：万能信号发生器》一文中介绍的方法

生成基频 1000Hz、调制频率和调制范围 50Hz 的调制波形，频谱特性图 11。这是一个调频

/调幅波形的频谱。可以看到实际发生了基波与调制频率的二、三次谐波调制，如果调制范

围选得大，谐波将增加很多，频率组件的幅度对比也会发生很大变化。 



45 
 

 

图 11 

图 12 是过零调幅波形的频谱。频谱成分很纯，只有基频加减调制频率得到的两个值。 

 

图 12 
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到这里我们必须澄清一个问题，即标准的调频、调幅波到底是怎样的？为什么上述生成的调

频、调幅波没有给出纯粹的单频调制结果？根据电子学的相关知识，对于调频波，是不可能

产生纯粹的单频调制的，只能靠缩小调制带宽的方法来尽量抑制谐波调制（调制带宽与调制

频率的比值称为调制系数，模拟调频广播实用中远小于 1），但结果是调制频率与载波频率

的幅度比大幅缩小，效率降低。图 13 就是将上述波形的调制范围缩小到 5Hz 时的频谱。谐

波调制成分少了，但信号/载波的比率已经降低到-24dB 以下。 

 

图 13 

实际应用中，不可能为了抑制谐波调制而无限制地缩小调制范围，因为那样必然造成信噪比

的急剧下降，结果反而更坏。因此必然是权衡、妥协和优选而得到一个折衷的方案。你肯定

对调频广播中特有的“沙沙”噪音印象深刻吧，这很大部分就是由于存在高次谐波失真而造成

的。但是对于调幅波，理论指出确实是可以产生纯粹的单频调制的。这说明我们以前产生调

幅波的方法有问题。为此笔者认真反思，找到了正确的调幅波产生方法。在产生“过零调幅

波”时，将第二次的调制频率设定“DC Offset”（直流偏置）为 50%至 100%，然后执行“调制”

选项，将得到纯粹的调幅波。如图 14，波形看起来跟以前的方法产生的差不多。 
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图 14 

但是频谱却有区别，见图 15，只有基频和基频加减调制频率得到的两个频率成分。这才是

真正的标准调幅波。（这时也就将软件选项命令的涵义澄清了：“Overlap(mix)”就是“重叠混

合”，不具备调幅功能，虽然用调频波混合的方法可以产生不严格的调幅波；而“Modulate”

才是真正的调幅命令。） 

 

图 15 
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图 16 是复合音的频谱。这时实际上根本没有发生调制，只不过是简单的混合。这也正是测

试互调失真时用复合音信号的原因所在，本身不存在调制，才能更好地测量调制产生的失真。 

 

图 16 

再看看脉冲频谱。图 17 是一个宽度为 20 微秒的单脉冲波形。极限放大到单取样点显示。 

 

图 17 
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它的频谱曲线是连续的，平直地延伸到 40KHz 以上，如图 18。这就是声学测量中用短脉冲

测试频响的根据。而且它有一个非常大的优点：可以用一个时间窗口来滤除反射波，在普通

环境中得到类似于消声室的结果。 

 

图 18 

5. 频谱对比分析 

如果我们想对比两个或几个波形的频谱特征，该怎么办呢？不必发愁，Adobe Audition 为

你考虑得很周到！看到频谱分析窗口右上角的“Hold”字样和“1、2、3、4”四个按扭了吧，它

们就是为你锁定谱线对比显示而设计的！ 

打开一段波形例如上述的扫频信号，打开频谱分析窗口，点击波形窗口的一点，频谱分析窗

口马上显示出该点频谱分析的结果。点击任一个“Hold”键，频谱曲线将以该键对应的颜色锁

定。点击波形另一点，得到另一个频谱曲线，再点击另一个“Hold”键，将其锁定……这样将

四个频谱曲线锁定后，还能够显示另一条“活”的频谱曲线。图 19 是任意选定上述扫频波形

中四点频谱曲线锁定后并显示另一条频谱曲线的情况。 
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图 19 

另外一种操作方法是锁定一条频谱曲线，然后打开另外一个波形来进行频谱分析，频谱曲线

将在同一窗口对比显示，这样你就可以进行多达五个频谱 包含声卡本底噪声、频率响应、

互调失真、总谐波失真四个频谱曲线对比的图例。 

 

图 20 

6. RMAA 测试信号分析 
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在此前 RMAA 测试软件的介绍中，笔者曾提到 RMAA 的测试信号特征，其实就是根据 Ado

be Audition 的频谱分析结果得出的结论（当然包括软件作者在帮助文件中的说明），现在

就让我们一起看个究竟。将 RMAA 测试信号保存为 WAV 文件，用 Adobe Audition 打开，

波形如图 21： 

 

图 21 

第一段为校准/同步信号，为一段 1000 Hz 纯音。第二段为频响测试信号，从波形看像白噪

声，其实并不是。频谱分析结果如图 22： 
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图 22 

可以看到频谱是不连续的，各频率间幅度关系也不平衡，这是为了接近实际的音乐平均频谱

而专门设计的。正因为如此，RMAA 的频响分析才需要用录制信号的频谱与原始频谱比较

而得出频响曲线。而如果用标准的白噪声信号测试，只需直接显示录制信号的频谱，因为白

噪声信号的频谱本身是一条水平直线，比较不比较没有什么差别。第三段为静音，用来测试

本底噪声。第四段为-60dB 的 1000 Hz 纯音信号，用来测试动态范围。该段电平低，需要

大幅放大才能看清，如图中圆角方框内所示。第五段为 0dB 的 1000 Hz 纯音信号，用来测

试总谐波失真。第六段为互调失真测试信号，它和总谐波失真测试信号都是可以自由设定的。

图 23 是软件默认的测试信号频谱： 

 

图 23 

第七段为通道分离度测试信号。看起来与频响测试信号一样，实际上有区别，如图 24 所示，

这里各频率成分的幅度是一样的。 
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图 24 

可以看到，波形显示（时域分析）和频谱显示（频域分析）是反映信号特征的两个重要手段，

二者结合将对全面了解信号特征起到强有力的作用。实际上对于双声道信号，还有一个重要

的研究手段——相位特性测量，Adobe Audition 也可以做得很好，放到下一篇结合 Adobe 

Audition 的编辑功能讲解。 

（三）：数字存储示波器 

示波器是了解信号特征非常有用的仪器，是几乎与万用表一样通用的基本测量设备。然而对

于业余爱好者，示波器的普及率远远比不上万用表，原因很简单：太昂贵。特别是数字存储

示波器，一般人更是可望而不可即。现在，我们利用电脑强大的处理能力和声卡高精度的 A

D/DA 界面，加上 Adobe Audition 强大的录制和显示功能，数字存储示波器的功能即可轻

易实现！ 

1.波形录制及存储 

用 Adobe Audition 当作示波器时，首先我们需要指定波形输入的通道，跟使用示波器指定

通道类似，不过可选的通道更多，更复杂。打开 Windows 的“控制面板=>声音和多媒体=>

音频=>录音=>音量”，在“录音控制”窗口中将“Mic Volume”选中，即可通过麦克风端口输入

信号。接好麦克风，准备录音！（如下图） 
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打开 Adobe Audition 程序，进入编辑处理界面。这时“录放工具”栏只有“Record”按钮是激

活的，其它按钮都变灰不可操作，波形窗口也是灰色无任何内容。这时点击“Record”按钮即

可开始波形录制及显示。（如下图） 

 

与新建波形一样，录音开始前会弹出对话框要求选择取样频率、声道数和分辨率。当然也可

以先新建空波形再录音。不过一般多媒体声卡的麦克风输入都是单声道的，即使选择立体声

也只有左声道有输入信号，但程序会将波形同时输入到右声道录制下来。（如下图） 
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点击“OK”按钮，开始录音！说一句“欢迎使用 Adobe Audition”，然后点击“停止”按钮，录制

完的声音波形便在波形窗口显示出来了。（如下图） 

 

2.线路录音 

有朋友要说了，你这是“录音机”，不是“示波器”！呵呵，往下看！一般我们用示波器都是直

接输入电信号，现在我们就试试！在“录音控制”窗口中选择“Line In”即线路输入端，即可输

入电信号显示。一定注意，如果电信号电压比较高，需要另加衰减和保护电路，否则很容易

烧坏声卡！衰减用一只合适的电位器即可，保护电路可以参考我的《用 RMAA 测试和设计

音箱》一文。 
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如何调整到合适的输入电平呢？窗口下部的电平表可以给你指示。调节 Windows 的“控制面

板 à声音和多媒体 à音频 à录音 à音量”，在“录音控制”窗口中调节线路输入的音量滑块，

使电平表的平均值指示在-6dB 至-3dB 即可。一般不要使输入音量过大，否则容易发生过载，

产生削波失真。如果不小心关闭了电平表，可以选择“ViewàShow Level Meters”或按“Alt+

7”键来打开。（如下图） 

 

这样我们就可以输入音频范围的任意波形来察看了。比如我们在电子学习中最基本的内容之

一，RC 滤波和 LC 滤波，以往我们只是理论上学习和分析，没有直观的认识，现在就让我

们来看看“庐山真面目”！（如下图） 

 

首先打开一个 Adobe Audition 程序作为“信号发生器”用。还记得怎么产生复合音吧？这里

我们就试试生成 60/7000 Hz 的复合音信号。点击“GenerateàTones”，选中“Lock to these

 settings only”，基频设为 60Hz，第一频率组件 X1，幅度 100%；第二频率组件 X116.66

6，幅度 100%；总音量-6dB，长度 0.5 秒。生成的波形如图所示。（如下图） 
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生成立体声信号是为了用一个声道作为标准参照，更容易理解信号处理前后的特征。点击“播

放”按钮，信号将从声卡线路输出端输出。 

将右声道信号接到图示的高、低通滤波器上，输出端将输出滤波后的高/低频信号，这里分

别是 60/7000 Hz，接到声卡线路输入端即可用 Adobe Audition 显示出来。（如下图） 

 

这里有个问题，程序与录音机类似，“播放”与“录音”是不能同时操作的，那么我们如何进行

录音呢？很简单，再打开一个程序窗口作为“示波器”用就可以啦！（大部分 Windows 程序

都可以打开多个窗口操作，只有少数例外）。在 WIN98 下会弹出一个窗口警告，“不推荐在
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此操作系统下打开多重 Audition 程序窗口，是否继续？”别理会，点“Yes”打开就是了，不

会出什么问题的。（如下图） 

 

先在第二窗口点击“录音”按钮，然后切换到第一窗口点击“播放”按钮，再回到第二窗口，等

播放完毕点击“停止”按钮，即可看到录制完的波形。这是低通滤波后的波形。（如下图） 

 

这是高通滤波后的波形。（如下图） 
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3.波形显示控制 

可以看到，Adobe Audition“软示波器”与真实的示波器不同之处在于难以实时显示波形细

节，但实际上将波形全部录制下来再慢慢看具有更大的优越性。而 Adobe Audition 的波形

显示功能是极其强大和完善的，你可以一直放大到以单取样点长度的分辨率来显示，这对于

模拟仪器来说是“不可能完成的任务”。另外显示的模式也是多种多样的，十分方便于各种不

同的用途。 

将光标移到波形窗口的水平标尺上点击鼠标右键，弹出选择窗口。你可以选择“Display Ti

me Format”（时间显示模式）、“Snapping”(捕捉)、“Zooming”（缩放）三个选项。（如下

图） 

 

在“时间显示模式”栏目可以选择多达 10 种显示方式，不过其中大部分是为了适应通用的音

频、视频格式而设置的。对我们作为虚拟仪器的应用，只有两种是适用的，即一般默认的“D

ecimal”（小数）和“Samples”（取样点）。“小数”即以时/分/秒的格式显示，时间短时以小数

值显示秒；而“取样点”显示方式是以每秒若干点的格式来显示的，点数等于波形的取样频率

值。（如下图） 
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“捕捉”栏可以选择选取波形时捕捉到的方式，具体应用以后结合编辑操作详述。“缩放”栏可

以选择缩放操作方式，与“缩放工具”栏的按钮作用是一样的，具体应用很容易理解，一试就

会！（如下图） 

  

将光标移到波形窗口的垂直标尺上点击鼠标右键，弹出选择窗口。（如下图） 

 

你可以选择“Sample Values”（样本数值）、“Normalized Values”（标准化值）、“Percent

age”（百分值）、“Decibels”（分贝值）来显示垂直坐标，并可以自由缩放。 

在水平/垂直标尺上用右键拖动选取加左键拖动移动的方法可以很快选取和移动到想要查看

的部分。放大的极限是单取样点。（如下图） 
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4.方波、三角波示波 

方波、三角波实际是属于脉冲类的波形，在电子电路中一般是以它们的负波峰作为 0 参考

电位的。但是我们用的声卡是交流设备，无法输出和输入直流信号成分，因此输出和输入方

波、三角波都是以其平均值中点为参考电位的。 

将声卡的“线路输出”和“线路输入”端用对录线直接相连，即可直接录制 Adobe Audition 产生

的方波、三角波，从而可以仔细考察声卡输出和输入方波、三角波的情况。 

这是 100Hz 方波用创新 Vibra128 录制的波形。稍有变样。（如下图） 

 

这是 100Hz 三角用创新 Vibra128 录制的波形。基本上没变样。（如下图） 
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再看看低频信号。5Hz 方波录制显示的情况。（如下图） 

 

5Hz 三角波录制显示的情况。（如下图） 
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咦，怎么波形完全变样了？对，这就是由于声卡的输出/输入带宽有限所致。在《用 RMAA

测试和选择声卡》中我们可以看到，创新 Vibra128 的频率响应曲线低频端从 30Hz 就开始

衰减，到 20Hz 处衰减斜率已经相当大了，不能正确反映 5Hz 的波形也就理所当然了。 

所以我们在使用中一定要对声卡的性能指标了如指掌，方能做到合理运用，正确分析。一般

多媒体声卡的输入波形带宽都应该限制在 20Hz 至 20KHz 间，才能得到正确的波形显示。

不过有些例外，例如 CMI8738 的频率响应就非常好，从接近 0Hz 一直到 22KHz 频响曲线

几乎是一条直线（可惜其它指标不太理想，否则就可以媲美高档的专业声卡了）。用这样的

声卡显示低频信号正合适。这是 CMI8738 声卡 5Hz 方波录制显示的情况。三角波就省略了

吧，看起来跟原始波形没什么差别。（如下图） 
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5.单脉冲及脉冲响应示波 

理想的单脉冲是没有时间长度的，也就是说它的幅度在趋向于 0 的时间内即可达到额定值

然后立即降为 0。实际上这样的信号当然是不存在的。实用的单脉冲一般是很窄的方波、三

角波的半周波形。 

脉冲信号是一类特殊的信号，其产生、录制、分析都有一定的要求，否则容易得出错误的结

果，培养出错误的观念，这点必须注意。 

脉冲产生电路有很多，像 555 集成电路就可以方便地产生单脉冲、连续脉冲。用手直接碰

接电源的方法不科学也不准确。这里用一个简单的机电式电路来产生单脉冲。如图所示，先

将电容 C 接入 12V 电源充电，然后接入继电器电路，使继电器短暂吸合再断开，电路输出

端便输出一个脉冲。（如下图） 

 

这个脉冲的特点是电压低，内阻低，驱动力强，不过不容易做到时间短。将此脉冲直接录制

下来可以看到其宽度约 50 毫秒，由图中可以看出，脉冲从 O 点开始，达到峰值 A 点后，

声卡输入电容充电电流开始减小，波形幅值开始回落，到 B 点脉冲结束，电容开始放电，

形成一个负峰值 C，放电以较缓慢的速度结束，到光标处 D 点基本回 0。进一步的实验研究

表明负峰值的幅度与 AB 点间的差值相等，X轴上下部分的包络面积相等，即总的波形没有

直流分量，脉冲越窄，负峰值反应越小。（如下图） 
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再看一个由电容放电产生的脉冲波形。将一个 100 微法的电容充电至 1.2 伏，然后接入正

在录音的声卡输入端，得到如图所示的波形。可以看到，脉冲没有明确的结束点（实际上是

一个宽三角波），声卡输入电容放电的开始也没有形成反峰值，这是由于外接电容吸收了放

电峰值所致，由此可见输入电阻大时用大电容产生脉冲是不可取的。（如下图） 

 

清楚了纯脉冲录制波形的特性，有助于正确认识和分析脉冲反应波形的特征。如图所示，这

是一只 8 英寸口径扬声器接受上述方波脉冲冲击的电反应波形记录。注意应该选择大口径

低频扬声器，否则其后沿振荡反应不明显，容易产生误解。由上述波形我们可以分析出扬声

器的脉冲反应特性是调制在纯脉冲录制波形上的振荡波形。（如下图） 

 

一个特例是接入扬声器后由于输入端电阻很小，可以用一只较小的电容充电作为脉冲源使

用，将产生很窄的脉冲，得到近于真实的扬声器脉冲反应曲线，如图所示是用 100 微法的

电容充电至 1.2 伏冲击上述扬声器的结果。（如下图） 
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上述扬声器脉冲反应的后沿开始都 有一条很陡很窄的负峰值线，这是扬声器音圈电感产生

的感应脉冲。 

如果用大电容作为脉冲源使用，而且扬声器口径太小，几乎无后沿反应，则容易将声卡输入

电容放电波形误认为是扬声器的后沿反应，这是不正确的。（如下图） 

 

所有的上述实验现象都可以归结到一个理论问题：电路的时间常数。大家可以参考有关的电

子学教材和书籍，这里就不再详述了。 

6.直流示波 
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Adobe Audition 是可以产生和记录直流信号的。不过需要一些技巧。直流信号可以用产生

方波的方法做出来。在产生方波时，将基频设定为很小的值（Adobe Audition 基频数值输

入框只能显示 6 位数，但是你可以在“0.”小数点后输入 N 个 0，最后再填 1，得到一个非常

非常小的数值。“N”可以填很多很多，但软件保存的有效位限制是 7。）长度几秒至几十秒，

即可得到全部是峰值的直流信号。（如下图） 

 

但是直流信号的输出和录入却不那么容易。因为一般声卡都是一个交流设备，它并不能正确

地输出和录入直流信号，而且一般声卡在 20Hz 以下就有严重衰减。即使像 8738 这样低频

特性好的声卡，还是不能直接录制直流信号，因为它的输出输入端都含有隔直电容。 

实验表明 8738 的内核是支持直流信号处理的（其它常见的声卡都不支持），在 WIN98 下

可以正确处理直流信号（不过在 WIN2000 和 WINXP 下一般信号的录制都有问题，更别提

直流了。笔者至今尚未找到在 WIN2000 和 WINXP 下反应良好的驱动）。只要将其输出输

入端的隔直电容换成 100 欧电阻，然后将地端断开接到 1/2VCC 电压，即可输出和输入直

流信号。改接前后的电路如图所示，为了简便，只画出一声道。 

改接前（如下图） 
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改接后（如下图） 

 

这是改动前的 8738 声卡录制的 0.5Hz 三角波。（如下图） 

 

这是改动后的 8738 声卡录制的 0.5Hz 三角波。（如下图） 
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能够正确处理直流信号，就可以对一些变化缓慢的信号进行测控，例如直流电压、温度、湿

度、位置、压强、压力……等等，只要用合适的传感器将变换后的电信号输给声卡即可。这

样可以极大地扩展该虚拟仪器系统的用途。 

Audition cs6 高清视频教程下载链接，中文字幕： 

http://pan.baidu.com/share/link?shareid=138474&uk=151710621 


